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重重要要事事项项  ::   在在开开始始使使用用本本软软件件前前，，请请先先阅阅读读以以下下条条文文  

 

 

多谢阁下选购适马产品。 

 

为令阁下能够享受到本产品所提供之最佳效能；而不会导致任何损坏和受伤；请务必在使用本

产品前，小心阅读本用户手册。 

 

通告 

• 在未获得批准前，请勿以任何方式，另行编辑此手册之全部或部份内容。 

• 此手册之内容，如有修改；将不会另行通知。 

• 虽然本公司已经尽一切可能性准确地编辑本手册；但如阁下遇到任何错误，请尽速联络

本公司之客户服务部。而任何错误损失，本公司概不负责。 

• 本产品之规格附件，如有修改；将不会另行通知。 

• 凡此软件之操作所招致之任何结果，适马及其有关之注册公司均概不负责。 

 

为免导致任何损坏和受伤；请务必在使用本产品前，小心阅读以下条文。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

请阁下严谨地使用本数码相机拍摄照片，请勿使用任何方式以触犯国际及本地版权法例及规

条。另外，本产品纯供个人拍摄用途。在摄影陈列、论证示范、商业性展览时，必需遵守其版

权及法定权上的守则。 

 

版权注释 

 FOVEON 为 Foveon, Inc 公司的注册商标，而 X3 和 X3 标志均为 Foveon, Inc. 商标。 
 Macintosh 和 FireWire 是在美国和其它国家的 Apple Computer Inc. 之注册商标。 
 Adobe 和 Photoshop 均为 Adobe Systems Incorporated 之注册商标。 
 Macintosh 和 FireWire 是在美国和其它国家的 Apple Inc. 之注册商标。 
 

警告 !! 

请不要将本产品内附之光盘放在音频光盘播放器内。如使用本产品内附之光盘放在 
音乐光盘播放器内，并利用耳筒聆听，可能令听力受损。而使用本产品内附之光盘放在音乐光盘

播放器内，亦可能令喇叭损坏。 

警告 !!  如忽视此警告标志，在使用本产品时可能会导致严重受伤或危险结果。 
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在此章节中，你会学到 … 
 

• Sigma Photo Pro 的主要特性。 

 

• 如何使用此用户手册。 
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11..11  关关于于  SSIIGGMMAA  PPhhoottoo  PPrroo  

你可以利用 SIGMA Photo Pro 作什么用途 ? 欢迎光临快速虚拟旅程 !  

以下是适马数码相机所用之 SIGMA Photo Pro 图像处理软件的不同窗口和调色版。请按入任何窗口

和调色板，便可以跳到详细解说的画面里。) 

 
主窗口 
SIGMA Pho

 

 • 由数码相机里复制图像到你的计算机中。 

• 将图像转换成 TIFF 或 JPEG。 

• 可在计算机和数码相机内，将图像加入符号、

锁定、旋转及删除。 

• 打印 

• 幻灯片展示 

• 文件名称更改 

图像数

• 检视拍摄

• 检视图像

• 检视数据

• 将图像加

旋转及删

• 可将图像

显示 

• 动[态修

• 打印汇入
to Pro  用户手册

据窗口 

资料 

数据 

处理 

入标记、锁定、

除 

自由在主窗口中

正模式 

及汇出设定 

修正调色板
• 修改图像的

色彩饱和度

• 色彩修正。

• 将用户自行

• 检视矩形图

• 设定高光及

• 白平衡修正

• 色彩模式设

• 減少色度和

检视窗口 

• 选择图像修正模式 

• 图像储存 

• 放大镜详细资料或放大倍率 

• 检视覆盖及阴影提示讯息 

• 将图像加入标记、锁定、旋转及

删除 

• 可将图像自由在主窗口中显示 

• 动[态修正模式 

• 存取及储存设定 
  

 
曝光补偿、对比度、阴影、高光、 

及补光。 

 

修正的设定，使用加载、储存和删除等功能。

。 

阴影提示讯息。 

 

定 

發光性的噪訊。 
2 
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主窗口之原件 

以下是主窗口的关键原件。请按入快捷方式，便可观看详细说明。 

 

 

 

 

 

 

 
按上 Review Images 按钮  p. 23 按上 Save Images As 按钮 p. 31 将

相机方框 p.10，相机 (SD9/SD10) 的连接显示，按

入相机方框便会在预视方框内显示所储存的图像。 

按入 复制相机图像按钮 p. 14 便可从相机

(SD9/SD10) 传送 X3F 图像到计算机。 
SIGMA Phot

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

计算机方

机(SD1
看硬盘容

开启检视窗口，以较大尺码检视及修改图像。
X3F 图像 储存成为 TIFF 或 JPEG 档案

模式。 
o Pro  用户手册 

框 p. 17 在计算机中显示硬盘及数据夹

4/DP1)已连接计算机，用户便可按入标志

量和数据夹数据。 

按上 数据按钮 p. 44 

开启图像数据窗口。 

使用 预视图片按钮  p

式。 
使用 编辑按钮  p. 20 可选用: 旋

转、标记、锁定、删除或检视附加数

据。
 3 

，如相

以查

. 18 控制预视图片的尺码和款

预视方框p. 16 可从相机或所选取

的数据夹以直接显示图像。 
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SIGMA Photo Pro  用户

检视窗口之原件 

以下是检视窗口的关键原件。请按入快捷方式，便可观看详细说明。 

按上 数据按钮 p.

启图像数据窗口。

 

按上 Adjustment Control 

p. 35 开启修正操控调色板。 

按入浏览按钮 p. 24 可选取下一

幅或上一幅图像。 
按上 放大  按钮 p. 25 

可将图像显示尺寸放

大缩小。 
 

按上 浏览按钮 p. 24 控制检视 

图像的前后方向。 
按上 Save Image As  按钮  p. 32

处理 X3F 图像并储存成为 TIFF 或

JPEG 档案模式。 
按上Fit in 按钮 p. 25 可调 

整图像至符合窗口大小。 
手册 

使用 编辑按钮

定、删除以修正
 44 开

 

放大镜 p. 24 可显

示图像的文放大

部分。 
按上 X3F 按钮 p. 26  便可将实时

之修改设定套用在 X3F 档案中。

如是 JPEG 和 TIFF，档案便会被覆

写。) 
 4 

  p. 20  可选用: 旋转、标记、锁

检视图像。 

修正模式 p. 10 容许检视

图像时 

应用不同的修正模式。 
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SIGMA Photo Pro  用户手册  5 

11..22  关关于于用用户户手手册册  

此用户手册主要是向各 SIGMA Photo Pro 使用者提供有关安装和软件使用数据。 

而 SIGMA Photo Pro 为适马数码相机的专用软件。 

 

符号图像之代表意义 

 

• 选单的路径如下: 

 Menu Header > Menu Choice 
 

• 键盘快捷方式指示如下: 

Cmd /+字母或符号 
 
“Cmd” 这是麦金塔键盘上之功能的缩写。 

 

画面浏览式的用户手册 

如要在使用 SIGMA Photo Pro 时观看用户手册，请在任何窗口选单中选择 说明 > SIGMA Photo 

Pro 说明  。 

 

以下是以 “PDF” 档案模式 的画面浏览型用户手册，目的是方便用户能更快速地浏览和寻找。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

使用书签模式搜寻 
各种主题目 

利用搜寻功能，以寻找 
关键词眼。 



   

S

22   计计算算机机设设定定  
IGMA Photo Pro 用戶手冊  6 

在此章节中，你会学到 … 
 
• 如何在计算机安装 Sigma Photo Pro 。 
 
• 如何调整你的监视器。 
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SIGMA Photo Pro  用户手册  7 

22..11  在在个个人人计计算算机机上上安安装装软软件件  

个人计算机的系统资源需求 

如要在你的个人计算机上使用适马数码相机和 SIGMA Photo Pro，请参考以下系统资源的最低需

求。 

  

• PowerPC®, G4, G5 处理器或 Intel ® Core TM Duo 处理器 

• Mac OS X  v10.4 版或以上 

• 512MB 内存或以上 

• 1GB 或以上可用硬盘容量 

• 建议 16-bit (65,000 色彩) 和 24-bit (16,770,000 色彩) 显示卡 

• 1024x768 解像度或以上 

• USB 或 FireWire (只适用 SD9/SD10) 连接 

• CD-ROM 光盘 或 DVD-ROM 光盘) 

 

安装和移除安装软件 

安装 SIGMA Photo Pro 

如要安装软件，请依据以下步骤。 

1. 请将 SIGMA Photo Pro 安装光盘放进光驱。 

2. 请按入 SIGMA Photo Pro 3.0 之图示；并拖放 SIGMA Photo Pro 夹到麦金塔 HD 的程序夹中。 

* 如要开启程序夹，请在选单选取 GO>Applications。 

3. 当复制完毕；安装亦将会完成。 

 

移除安装 SIGMA Photo Pro 

如要移除安装软件，请手动地删除已安装的 SIGMA Photo Pro 夹。请删除以下档案或数据夹。 

1. 请拖放在程序夹中的 SIGMA Photo Pro 夹到资源回收筒。 

2. 请在程序夹删除以下档案。 

 “com.sigmaphoto.photopro.plist” 在参考夹內 (Macintosh HD / Users / User Name / 

Library / Preferences) 
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22..22  显显示示器器设设定定  

检查显示器的光暗度 (brightness)、加玛值 (gamma) 和色彩度 (color) 

在主窗口里选取 “Tools” -> “Monitor Verification”。 

 

以下的图表只是用作确认 色彩度 (color) 和 加玛值 (gamma) 的参考。请使用显示器上的控制台

和参考显示器厂商所提供的使用手册以作出适当的调整。 

 

请将显示器的色彩度与图像原色尽量调节一致。如显示器之性能暂未能符合要求，请定期检查显示

器的表现，及参考显示器厂商所提供的使用手册。 

 

使用显示器预设设定  

SIGMA Photo Pro 支持显示器预设设

定。如需要显示器数据，请参阅显示器

厂商所提供之使用手册、调节显示器设

定之软件或系统指引。 

 

选择符合显示器尺码的最佳解像度 

SIGMA Photo Pro 的最佳画面解像度是 

800x600, 但在检视图像和使用预视功

能 时皆可使 用较大的 画面解像 度

1024x768 或其它尺寸的解像度；以较

弹性地检视图像。  

你亦可以更改主窗口、检视窗口和预视

窗口的尺寸及在画面上自由移动不同位

置。 

 



   

S
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在此章节中，你会学到 … 
 
• 如何将数码相机连接上你的计算机。 
 
• 如何开始使用 SIGMA Photo Pro 
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33..11  将将数数码码相相机机连连接接上上你你的的个个人人计计算算机机  

当使用 SIGMA Photo Pro 时，SD9 或 SD10 相机只可单一连接。而 SD14 和 DP1 相机却可以超过

一台以上连接计算机。 

为保障软件能操作正常，请先将其它相机断线。 

 

接线连接 

要将数码相机连接上计算机，请使用 USB 接线或 IEEE 1394 (FireWire™ )  (只适用 SD9/SD10) 

接线；及将数码相机关闭。请勿将数码相机同时连接 USB 和 IEEE 1394 (FireWire™ )。 

 

开启数码相机 

开启数码相机的方法，请参阅用户手册。除非数码相机在连接计算机后开启，否则 SIGMA Photo 

Pro 是不会侦测到数码相机的。 

 

当数码相机(只适用 SD9/SD10)开启及连接上计算机，SIGMA Photo Pro 会自动启动。蓝色的数码

相机方框会出现于主窗口的右方。于数码相机的 CF 记忆卡内图像会自动显示在预视窗口上。 如数

码相机并无图像档案，便不会有图像显示在预视窗口内。 

 

连接相机(SD14/DP1) 

连接 SD14 或 DP1 到你的计算机然后开启相机，SD14/DP1 便会被指定为可移除硬盘。(而 SD14/DP1 

亦会在桌面上被指定了一个可移除硬盘标志。 

如要显示在相机里之 CF 卡/ SD 卡的图像，请按入预视方框。假如图像不能在预视方框上显示，理

论上图像并不在卡中。 

 

注意: 当 SD14 或 DP1 被指定为可移除硬盘时，电量及 CF 卡之现况并不会显示出来。 

 

连接相机 (SD9/SD10) 

当相机连接到计算机并閞启相机时，SIGMA Photo Pro 便会自动运作。CF 卡内之图像便会在预视方

框内显示。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

记忆卡图标会指示数

码相机和 CF 卡正在

连接中。 

此为电池或交流电电源

图示，在数码相机中指

示用户正在使用何种电

源。 

蓝色横条会指示数码相

机内的图像，并显示在

预视窗口。 
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从充电池转换至 AC 交流电 (SD9/SD10) 

建议当数码相机连接上计算机时使用 AC 电源。因为使用 AC 电源时会节省电池用量，并且在图像转

移时避免因电量不足，而造成不必要的损坏。 

 

当数码相机转用 AC 电源时，AC 电源图示会自动转为电池图

示。 

 

当使用电池时，电池图示会定时转变为红色，作为提示电

池正在使用中。因此并不需要有低电量提示。 

 

 

 

当软件在运行中连接相机 (SD9/SD10) 

当使用 SIGMA Photo Pro 时，要连接数码相机，在其中之图像是不会自动在主窗口内显示。如要显

示数码相机内的图像，请选择数码相机方框。 

 

 

33..22  软软件件启启动动  

开启和关闭 SIGMA Photo Pro 

当数码相机被连接上计算机及开启时，SIGMA Photo Pro 会自动被启动。同时主窗口和数码相机方

框会同时出现。如图像没有在预视窗口上显示，而 SD9/SD10 数码相机内又确实有图像的话；可能

计算机未能与数码相机连接上。 

 

用户可以在非连接相机时开启 SIGMA Photo Pro。软件主窗口会出现并在

计算机方框显示最后开启 

资料夹。任何 X3F、JPEG 及 TIFF 图像皆会显示。如用户是第一次开启

SIGMA Photo Pro 软件， 

便不会有数据夹被选取。 

 

如要退出软件，请按入主窗口的红色按钮，或从主窗口选单选取 SIGMA 
Photo Pro > Quit SIGMA Photo Pro。 

 
注意: 如要使用本软件，必须遵守许可同意书。请小心阅读许可同意书，如接受请按上 “Yes 
按钮。但如按上 “No” 按钮，安装程序便不能完成。 
 

使用和取消自动执行模式 

当适马 SD9/SD10 数码相机开启及连接上计算机，SIGMA Photo Pro 的预设是会自动执行软件。但

如你不想使用此模式，你可以使用 “取消”自动执行模式功能。请到主窗口选单上选择  

Camera -> Auto-Launch Setting 。 
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44   图图像像转转移移

在此章节中，你会学到 … 
 
• 如何将图像从数码相机复制到计算机。 
 

• 如何在 CF/SD 记忆卡中删除已复制图像。 
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44..11  将将图图像像从从数数码码相相机机复复制制到到个个人人计计算算机机  

 

用户可以将图像从相机传送，并可同时储存图像档案到计算机数据夹中。(祇适用 SD14 和 DP1) 
 

注意: 图像档案并不能储存在只读光盘里。 
 

 

让 SD14 或 DP1 连接上计算机。 

当 SD14 / DP1 以 USB 接线连接到用户计算机时，计算机的桌面上便会出现可移除硬盘的标志。 

 

使用 SIGMA Photo Pro 3.1 将图像档案从相机转传到计算机。 

1. 转传图像到已存在之数据夹。 
 

1. 请选择储存位置以便将图像档案传送到计算机方框。) 

2. 如要显示你所选取的数据夹，请按上标志。如需传送图像，请选择数据夹。 

         

如用户要在已存在的数据夹或位置，再创建新数据夹，请在主窗口选取 File>New Folder 。 
 

2. 开启 SIGMA 数据夹 (相机创建之 DCIM 数据夹内) 及选取须要转传的图像群。) 

 

1. 在计算机方框中按入适马 SD14 或 适马 DP1 可移除硬盘的标志。 

2. 在适马 SD14 或 适马 DP1 可移除硬盘中，按入 DCIM 数据夹的标志。 

3. 在 DCIM 资料夹之下，按入 SIGMA 资料夹。 

4. 请在计算机选取所需传送图像。如要选取全部图像，请在主窗口中按入 Cmd + A 或 按入

Edit > Select All 。 

 

3. 开启适马数据夹 (在相机的 DCIM 数据夹里创建) 和选取及传送多个图像档案。 
 

1. 请将所选图像拉到目的地数据夹。 

2. 用户可以利用 Cmd + C 以复制图像或从“ctrl + click” 选取 “Copy”，如你想传送图

像，将鼠标浮标放在数据夹上，然后从“ctrl + click”  选单中按入 Cmd + V 或 

“Paste”  。  
 

以上步骤亦适用于从相机的 CF 卡/ SD 卡里复制图像档案到你的计算机内。) 
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连接 SD9/SD10 到计算机 

 

使用 “复制数码相机中的图像” 按钮 

为将 X3F 档案储存作未来之用，可将图像从 SD9 或 SD10 传送到计算机中。亦可选取部分图像到从

CF 卡传送到计算机。好处是当用户检视旧图像时，如要释放卡内空间可将图像删除。 

 

将 X3F 图像档案，由数码相机转移到计算机上的步骤如下:  

1) 连接及开启数码相机 

2) 在主窗口中的浏览方框内选取 “Camera”。 

3) 如只要转移某部份图像，请利用 选取(select) 或 标记(mark) 

(图像在数码相机内会被卷标，也会显示在 SIGMA Photo Pro。) 

4) 请按入 “复制数码相机中的图像” 按钮。 

 

 

对话匣会出现如下: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

使用 CF 卡读卡器复制图像到计算机 

SIGMA Photo Pro 亦可兼容 CF 卡读卡器。用户可利用读卡器以从 CF 卡将图像传送到计算机。 

 

 

 

来源地(Source):  

选择性地按上比例按钮、卷标或已选择的图

像；可用不同型式转移图像。 

转移选项(Transfer Option): 

如在方格内按入  号 ；表示当图像由数码相机转移

到计算机后，便会从 CF 记忆卡内删除。 

目的地(Destination): 

用户要在计算机中选取数据夹以储存 X3F 图

像，请按入 Choose 键。 

按入打开  便可开始转移 或 按入取消 便可返回主

窗口 
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55   图图像像管管理理

在此章节中，你会学到 … 
 
• 如何显示、检视和分类图像。 
 

• 如何选择和移动图像。 
 

• 如何重新命名图像。 
 

• 如何标记、锁定和旋转图像。 
 

• 如何删除图像。 
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55..11  主主窗窗口口概概览览  

主要功能 

主窗口的各种功能如下: 

• 由数码相机复制图像到个人计算机 

• 利用预视图框检视图像 

• 处理和储存图像群组 

• 复制和移动图像到新数据夹 

• 旋转、标记或锁定图像 

• 重新命名或删除图像 

• 存取图像数据窗口 

• 在检视窗口开启图像 

• 打印 

• 幻灯片展示 

 

当你选用数码相机方框或选用计算机方框时，图像会在预视窗口直接显示；而且被选择的方框会改

变为蓝色。 

 

当启动 SIGMA Photo Pro 时，主窗口也会同时开启。 如要注销软件，请关闭所有窗口和方框。 

 

其它信息连接 

按入以下各项快捷方式，可检视主窗口各原件的详细描述。 

 

 

 

 

 

 

处理和储存图像 图像数据 

 

更改预视外观型式 框 

从相机传送图像 

相机方框 
Mark, and lock images
 开启检视窗口 
幻灯片展示
删除 

预视方框

主窗口 

列印 
计算机方
图像旋转
16 
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更改主窗口的尺码 

如需改变主窗口的大小尺寸，请用 Zoom (+)键。再一次按入便可还原。如窗口在移动，可按入黄

色的 Minimize (-) 键以放回原地。用户亦可使用右下角以控制成不同的大小尺寸。 

 

改变浏览方框及预视方框的大小尺寸。 

如要更改计算机及预视方框的尺寸，可按着和拖曳两个方框之

间的间隔条。 当下一次再开启 SIGMA Photo Pro 时，是会记

着此新增的变改。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

55..22  在在主主窗窗口口显显示示图图像像  

 

 

 

检视数码相机内的图像 

按入数码相机方框的任何地方可显示图像群。数码相机方框横

条亦会变为蓝色 ，数码相机内的图像群会被显示在预视方框

上。 

 

检视个人计算机内的图像 

按入计算机方框可显示上一次的数据夹。计算机数据夹内的图

像群会被显示在预视方框上。  

 

注: 如上一次的数据夹被侦测到，计算机方框会被指着，但并

无数据夹被显示。 

 

按入已选择的硬盘或资料夹，便可以灰色条棒选取需要的 

资料夹。 

 

双按那数据夹，便可开启和显示副数据夹。 

 
注: 如预视方框并无显示图像，这说明数码相机内是无 X3F 图

像档案，或并无 TIFF、JPEG 和 X3F 在所选择的数据夹内。 
 

左右移动灰色间条可改变浏览方框及预视方

框的大小尺寸。 
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55..33  观观看看预预视视图图片片的的不不同同方方式式  

更改预视图片的尺码和款式 

 

按上在主窗口底部的预视按钮，以不同的尺码和有或无文字方式检视预视图片。 

 

预视缩放钮。 

如需改变预视大小请移动蓝点或按入两边按钮。用户亦可

选取 View > Small Thumbnail、Medium Thumbnail 或 
Large Thumbnail 。 

 

 

小型预视附上详细资料 

在主窗口选单中按上此按钮 或 选择 View > Thumbnails with Details 。 

 

 

 

 

 

 

 

分类和过滤预视图片 

在主窗口选单中可选择分类和过滤功能，以作预视之用。 除利用选单外，也可使用相关键盘字键

在预视方框，选择不同的预视组别。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

在硬盘或资料夹内，显视 X3F、JPEG 或 

TIFF 图像档案。 

过滤性地选择已卷标或锁定的图像。 

根据不同的款式，在预视方框内将图像

依指定型式挂列。 

在预视方框中返回上一个动作或将预视

方框内图像重新整理。 
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55..44  将将图图像像重重新新命命名名  

图像重新命名 

请在预视图按入 Ctrl + click 以显示选单，选取重新命名。 

 

群组图像重新命名 

在  “群组图像重新命名”的对话匣中容许在数据夹内选取全部图像以重新命名。先选取图像，在

主窗口选择 “档案”及再选取群组图像重新命名。可在匣内输入所须之名称；并可套用全部图

像；亦可同时输入以 # 为首的数字。 如新文件名称已存在于数据夹内，错误通讯息便会出现。 

 

在 SIGMA Photo Pro 以外重新命名 

如你在 CF/SD 记忆卡内更改 X3F 图像档案的名称 (IMG######/SDIM#####)，被更改的图像是不能

在数码相机内阅览的。但如将 X3F 图像档案复制到计算机内，便可被阅览。 

 

在计算机上，如你在 SIGMA Photo Pro 以外将档案的延伸重新命名；本软件仍然可以辨认此图像档

案 (. X3F)。其它两类档案延伸 TIF 和 JPG 可以保持不变。 

 

注意 : 当用户要改变文件名称时，请不要改变档案延伸名称。如档案延伸名称被改变，档案便不
能被 Sigma Photo Pro 承认。 
 

 

55..55  选选取取图图像像  

选择单一图像 

在预视方框，按上一幅图像。 双按那已被选择的图像，便会在检视窗口显示出来。 

 

选取多幅图像 

请参考以下程序，利用鼠标在预视方框 “选取”或 “不选取” 图像。 

 

• Shift + Click: 在预视方框内以连续方式选取图像。 

• 请在预视图按入 Cmd + click  便可(随机)不连续选择。 

• 按入 Cmd + A 可选取全部预视图。 

• 按入空格或用 Edit / Deselect All 以反选全部预视图。 

• 按入 Cmd+ Shift + I 可倒转所选的预视图。 

 

 

 

这是在预视方框，以选单方式和键盘快捷方式方式，选择 “选取”、 

“解除选取”、“剪下” 、“复制” 和 “贴上” : 
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55..66  在在主主窗窗口口及及检检视视窗窗口口内内，，将将图图像像标标记记、、锁锁定定和和旋旋转转  

图像旋转 

在预视方框内，使用旋转按钮或从编辑选单选择顺时针旋转/逆时针旋转；令图像改变

成为垂直或水平方向。在数码相机内旋转图像后；那图像会保持已旋转后的状态，被复

制到计算机。 

 

• 当选择图像，并按上左旋转按钮，便可将图像旋转至左方。 

• 如按上右旋转按钮，便可将图像旋转至右方。 

• 只有 X3F、JPEG 及 TIFF 图像可以被旋转。 

 

图像标记和解除标记 

在数码相机内，如你需要转移、复制、处理或移动图像，请使用图像标记；当被标记之图

像被复制到计算机后，图像仍然维持被标记状态。 

 

• 请选择单一或多个图像，按上 Mark 按钮以标记图像或从编辑选单选择标记。 

• 请选择单一或多个图像，按上 Mark 按钮以将图像的标记解除或从编辑选单选择解除标记。 

• 如一组图像群被使用标记或解除标记；其它图像也会被标记。 

• 如所有图像被标记，再按上 Mark 按钮，便会将图像的标记解除。 

• 只有 X3F 图像可以被标记。 

 

图像锁定和解除锁定 

锁定图像功能可以防止图像被意外删除。当被锁定之图像被复制到计算机后，图像仍然维

持被锁定状态。 

 

• 请选择单一或多个图像，按上 Lock 按钮可锁定图像或从编辑选单选择锁定。 

• 请选择单一或多个图像，按上 Lock 按钮可将图像锁定解除或从编辑选单选择解除锁定。 

• 如一组图像群被使用锁定或解除锁定；其它图像也会被锁定。 

• 如所有图像被锁定，再按上 Lock 按钮，便会将图像的锁定解除。 

• JPEG、TIFF 和 X3F 图像皆可以被锁定。 

 

注意 : 只读光盘媒介并不适用于以上程序。 
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55..77  在在主主窗窗口口及及检检视视窗窗口口内内，，将将图图像像删删除除  

图像删除 

 

 

 

• 请选择图像，按上 Delete 按钮 或 利用键盘上的 “Delete” 键或从编辑选单选择删除。 

• 会有一个删除的对话匣，指引你完成整个删除程序。 

• 如要删除已锁定之图像，请先将图像锁定解除。 

• JPEG、TIFF 和 X3F 图像皆可以被删除。 

• 在资源回收筒中，被删除之图像容许被回复。 

 

注意 : 只读光盘媒介并不适用于以上程序。 

 

 

55..88  在在主主窗窗口口及及检检视视窗窗口口内内，，打打印印图图像像  

圖像列印 

 

 

 

请按入打印按钮或在选单选取 File>Print 。如需进一步资料，请参阅10.1 节。 

 

 

55..99  在在主主窗窗口口内内，，以以幻幻灯灯片片展展示示观观看看图图像像  

在主窗口内用幻灯片展示观看图像。 

 

 

 

按上幻灯片展示按键或在选单中选取 File -> Slideshow ；如需进一步资料，请到10.2 节。 
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66   图图像像检检视视

在此章节中，你会学到 … 
 

 

• 如何开启检视窗口。 
 

• 如何在检视窗口内检视不同图像。 
 

• 如何使用放大检视图像数据。 
 

• 如何以图层功能检查阴影和覆盖。 
 

• 如何使用修改模式。 
 

• 如何显示多重检视窗口。 
 

• 如何在 X3F 档案中更新设定。 
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66..11  检检视视窗窗口口  

开启检视窗口 

如要显示检视窗口；请双按预视图片，或在主窗口中选取图像，然后按上 “Review Image” 按
钮。  

 

主要功能 

检视窗口的各种功能如下: 

• 以大型尺码及高解像度，检视个别图像。 

• 处理和储存个别图像。 

• 检视图像，并附上不同的修改设定。 

• 度身处理存取修改控制。 

• 图像标记、锁定、旋转或删除。 

• 可以在数码相机内或被选取的数据夹中，浏览其它图像。 

• 图像数据窗口的存取。 

 

其它信息连接 

按入以下各项快捷方式，可观看检视窗口各原件的详细描述。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

图像处理和储存 

图像数据 

检视其它图像 

检视窗口 

删

放大镜 

 

打印 
检视及储存图像，并附上不同的修改设定 
图像显示增大或缩小
自定修改 除 
 
图像旋转
 23 
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66..22  经经数数据据夹夹使使用用检检视视窗窗口口浏浏览览图图像像  

在检视窗口选取及显示不同图像 

当开启检视窗口时，会显示首个预视图片。在主窗口中双按任何预视图片；或在检视窗口上，选取

一幅预视图片，并按上 “Review Images” 按钮可替换图像。 

 

使用浏览按钮以选取图像 

按入检视窗口的浏览按钮，可观看在现存主窗口的预视图。 

 

 

当 Previous 按钮转成灰色时，即是这幅图像已是在数据夹内的首幅图像。当 Next 按钮转成灰色

时，即是这幅图像已是在数据夹内的最后一幅图像。  

 

在主窗口内，无论何时转换任何数据夹，在你由新数据夹将图像替换到检视窗口内前，浏览按钮的

左右箭头皆将不能使用。 

 

在主窗口内选取指定图像 

如要在主窗口检视指定图像；即是你已开启了检视窗口，于主窗口内双按

预视图片，此图片便会在检视窗口替换成为新图像。 

 

 

 

 

 

 

 

 

66..33  使使用用放放大大镜镜  

开启及关闭放大功能 

请按入放大镜按钮，而滑标转换成为放大镜。将放大镜放置在图像的所需范围

上。如要关闭放大功能，请再按放大功能按钮一次。 
 

更改放大倍率 

在预视窗口中之图像放大上限为 800% ；如需更改放大倍率，请按入箭头按键

的左方或右方。图像现存的大小，显示在箭头按键的中央位置。 
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活用放大镜 

 
如要使用放大镜，请在检视窗口上按入放大镜按钮。 
 

 

 
如要返回放大镜功能，只须在修正控制台上

按入点滴器，便可变回文放大镜或游标。 
 

 

 

 

 

 

 

 

如何在放大镜中观看 RGB 数值 

在放大镜范围的右下角部份会有 3 组红、绿、蓝的数值，是从放大镜的中央处 5 X 5 像素样本而

来。如需进一步数据，请参阅章节 8.3 – 色彩修正。 
 

 

66..44  使使用用放放大大功功能能  

页面适合按钮 

按上页面适合按钮可在检视窗口中调整图像至符合窗口 
大小。 
 

 

更改倍增放大功能 

在预视窗口中之图像放大上限为 1600%；如需更改放大倍率，请按入箭头按

键的左方或右方。图像现存的大小，显示在箭头按键的中央位置；放大下限

为 8.3% (1/12)。 
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66..55  检检视视带带有有高高光光和和阴阴影影的的图图像像  

使用遮盖功能分析高光和阴影 

如 “红色” 代表覆盖范围的数值超出指标，在修正控制调色板上的矩形图中会反映出来。 

同时，“蓝色” 代表阴影范围的数值比较指标数值为低，也会在修正控制调色板上反映出来。 

请参考 章节8.4 ， 该段落可以提供多一点有关 “高光” 和 “阴影” 等范围提示的数据。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

66..66  使使用用修修改改模模式式设设定定  

使用 “修改模式设定” 可以处理多种图像档案。 

 

当正在处理图像时，活动指针会出现在检视窗口的右上方的角落。当

指针活动停止后，图像会被更新至较高质量，并在现有的修改模    

式中反映出来。 

 

当图像档案是 X3F 格式。 

X3F 模式: 以预设修改模式检视图像 (符合数码相机内的预视形式) 

如选用 X3F 模式，所有储存在适马数码相机的图像，皆会显示在

检视窗口内；而此源文件是由适马数码相机所拍摄，并且没有进

一步的色泽比例或色彩的修改。如希望将修改设定储存在 X3F 档

案中，用户可以作后期修改并将设定储存。 

 

预设模式会维持状态，直至选取其它模式；或利用修正控制以手

动调整设定。 
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自动模式: 以自动修改模式检视图像 (视乎图像内容而定) 

如选用自动模式，每幅图像的设定，皆被自动修正，并会显示出

来。  

 

自动模式会维持状态，直至选取其它模式；或利用修正控制以手

动调整设定。 

 

如要看自动修改做了什么的话，可以阅览 “修正控制”。 在自

动模式中，每幅图像都被自动 

化控制。如你想进一步修改自动设定，可将 “修正调色板” 加以更新；而自动模式会被转变成  

“自定模式”。 

 

自定模式: 以特别自定模式检视图像 

如选用自定模式，每幅图像皆会显示在检视窗口内。并且 

会在自动选单上显示 “自定设定列表”；或显示未被储存之设

定。  

 

直至由自动选单上选取其它模式，自定模式会维持状态； 

或利用修正控制 使用手动调整设定。 

 

在选择其它模式后，上一次的自定设定亦会显示在自动选单上。而你可以利用自定模式再次修改设

定。 

 

储存未被存储的实时设定 

当 “Current Unsaved Setting” 显示在自动选单上时，在修正控制会显示现存的修改设定。  

 

 如你使用修正控制，以手动型式修改图像的话； “未被储存的设定” 便会在任何时间出现在自

动选单上。移动控制器或滑动器自动转换成为自定模式。 

 

用户可以在 “修改控制面版” 上的 “修正模式” 内，按入 “储存设定按

钮”，便能将更新设定存储；此功能容许用户将显示在程序上的 X3F 源文件直接修

改更正。 

 

用户如需要更改原始拍摄设定，可以将其存储在 X3F 中。如要转换 X3F 的已有设定，请按

入在 “修改控制面版”或“检视窗口”上的 “储存设定按钮”。除此之外，用户亦可以

选择将新设定转存为 TIFF 档案和 JPEGs 档案。用户可以下一次在检示匣中检查早前之设

定。 

 

当 X3F 按钮在非使用情况下；无论该设定在档案处理中，或是已经储存在 X3F 档案   

里；也只会显示已套用的设定。 
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当图像档案是 JPEGs 或 TIFFs 格式。 

档案模式: 在非修改情况下预视图像。 

已选取档案时，每一个图像均被显示成为预设修正。 

 

预设模式 (档案模式) 会维持状态，直至在选单上选取其它模

式；或利用修正控制以手动调整设定。 

 

 

自动模式: 以自动修改模式检视图像 

如选用自动模式，每幅图像的设定皆被自动修正而显示。  

 

自动模式会维持状态，直至选取其它模式；或利用修正控制以手

动调整设定。 

 

 

如要看自动修改做了什么的话，可以阅览 “修正控制”。 在自动模式中，每幅图像都被自动 

化控制。如你想进一步修改自动设定，可将 “修正调色板” 加以更新；请注意，自动模式会被转

变成 “自定模式”。 

 

自定模式: 以特别自定模式检视图像 

如选用自定模式，每幅图像皆会显示在检视窗口内。并且 

会在自动选单上显示 “自定设定列表”；或显示未被储存之设

定。  

 

 

直至由自动选单上选取其它模式，自定模式会维持状态；或利用修正控制 使用手动调整设定。 

 

在选择其它模式后，上一次的自定设定亦会显示在自动选单上。而你可以利用自定模式再次修改设

定。 

 

关于图像储存，请参阅 章节 7.2 

 

注意 :  JPEGs 及 TIFFs 格式是不适用于 X3F 补光功能。) 
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66..77  多多重重检检视视窗窗口口  

开启多重检视窗口 

用户可开启多个检视窗口以将不同图像作比较。要显示新增检视窗口，请在主窗口或检视窗口选取

File > Open New Review Window。 

 

当开启了多重检视窗口；请在主窗口，双按任何预视图片；图像便会显示在最高那个检视窗口上。 

 

注: 每个检视窗口都需会占用计算机内存；因此，当开启多重检视窗口，皆会令软件运行转慢。 

故此，要软件有较佳表现；如无必要，请关闭检视窗口。 

 

使用多重检视窗口作图像比较 

在不同的检视窗口内显示一些差不多的图像，容许用户在决定储存图像之前，作出详细比较；例如: 

图像的组合、表面层次或 焦点等。  

 

使用多重检视窗口的图像比较模式 

每个检视窗口都会保留自己的修正模式； 在检视窗口处理图像时，每个图像都会保留自己的修正

模式。在两个检视窗口内显示一些差不多的图像，容许用户使用不同模式对图像作比较。 
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77   图图像像处处理理和和储储存存

在此章节中，你会学到 … 
 

 

• 如何处理和储存图像。 
 

• 如何在图像处理时，选择解像度、档案类型和色域

等。 
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77..11  在在主主窗窗口口处处理理图图像像  

同时处理图像群组 

以组别方式，处理图像群组；好处是不必针对个别图像，故是快速处理 X3F 图

像档案的方法。你不可以更改个别的文件名称；同时，处理所有图像档案也需

要使用相同的设定。不过，假如你选 取 “自动修正设定”；SIGMA Photo Pro 会以最佳化方式，

处理每幅图像。 

 

处理图像群组的步骤如下: 

1) 选取资料夹内，包含了需要处理的 X3F 图像档案。 

2) 你可以处理整个数据夹内的图像、选取某些图像或已标记的图像。 

3) 选择或标记所需之预视图片。 

4) 按上 Save Images As 按钮。 

 

对话匣会显示如下: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
注意 : 以上程序并不适用于 JPEG 和 TIFF。 
 

目的地: 

选取在计算机中储存已处理的图像的位

置。 
31 

修正设定 

要处理图像请选取 修正模式。 

处理选项:  

请选择 档案输出类型 

 解像度 

 色彩空间 

按上 存储 可开始处理和储存；或 按上

取消 会回到主窗口。 

假如用户需要将 已储存的修正设定 套用

在 X3F 档案中，请用此选项。 

来源地:  

按上比率按钮，并选取图像群。 
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77..22  在在检检视视窗窗口口处处理理图图像像  

处理个别图像 

在检视窗口处理图像，就像在主窗口一样，并附加以下优点: 

 

• 当你检视图像时，其实有不少处理程序，已经办妥。因此储存的速度会较快捷。 

• 你可以重新命名那些已储存的图像档案。 

• 你可以利用 “修正控制调色板” 以修改设定。 

• 你可以在选取不同设定后，便可检视图像的详细数据。 

 

当你想处理已选择的图像，按入 Save Image As 按钮。 

 

对话匣会显示如下: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

选择目的地 

当用户储存档案时，可同时选择目的地。图像会储存于以前的储存数据夹中。如想改变目的地，请

按上 “选择”按钮及选取数据夹。) 

 

注意 : 以 JPEG 和 TIFF 格式储存，重复的处理会令图像质素下降。) 
 

目的地: 

按上 Choose 按钮；可选择图像档

案处理后之目的地。而且可以将图

像重新命名。  

按上 存储 可开始处理和储存；或 按上取消 会回到主窗口。 

处理选项:  

请选择 档案输出类型 

 解像度 

 色彩空间 

修正设定 (只适用于 X3F 档案) 

来源地: 

此项目会纪录及显示，图像的文件名称

和原始解像度；这些数据不能被更改。 

假如用户需要将 已储存的修正设定 套
用在 X3F 档案中，请用此选项。 
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77..33  处处理理选选项项  

要处理图像，可使用移动选单和比率按钮，并选取处理设定。而主窗口的 “Save Image As” 对

话匣和检视窗口的 “Save Images As” 对话匣是完全独立的。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

解像度 

软件预设的解像度和数码相机内之设定(High, Medium, or Low

在处理图像及存取至 JPEG 或 TIFF 时，选取 1 ½ 或 双倍的解像

字的像素 。 

 

修正设定 

在这设定里，共有 3 种选项 : X3F 预设  - 使用内置在数码相

动  - SIGMA Photo Pro 的自动化修改，和 自定 – 由用户自

请参阅  章节 6.6。而如需要有关储存设定的数据，请参阅  章

 

色彩空间 

根据输出所需，例如: 其它软件、打印机和用户收到的色彩数据

有特殊的色彩管理指示，我们推荐你使用个人计算机内的色域 

特殊色彩管理，你在移动页面上，根据你所需要的再选取其它色

上额外的 ICC 简要；请参考系统所提供的使用文件。    

 

档案输出类型 

Sigma Photo Pro 支援 JPEG, 8-bit TIFF 及 16-bit TIFF.  

质素 

用户同时可在储存 JPEG 档案时，改变压缩率。 

 

修正设定 (只适用于 X3F 档案) 

• X3F 

• 自动 

• 自定 
注意: JPEG 和 TIFF 不适用于此检视功能。

欲要将 X3F 档案储存更新，请选择 

stored adjustment settings 
解像度 

• 与原始尺码相同 

• 一半尺码 

• 双倍尺码 

色彩空间 

• sRGB 

• AppleRGB 

• Adobe RGB 

• ColorMatch RGB 

• ProPhotoRGB 

档案输出类型 

• JPEG 
• 8-bit TIFF 
• 16-bit TIFF 
33 

) 是一样的。在软件中，你也可以

度 (在每 … 中，1 ½ 或 双倍数

机或 SIGMA Photo Pro 的设定， 自
定。如需要有关如何设定的数据，

节 8.8。 

；可选取适合的色彩空间。如你没

(sRGB 或 AppleRGB。要作进一步的

彩空间。如你想在移动选单中，加
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88   图图像像修修改改  

在此章节中，你会学到 … 
 

 

• 如使用修正控制调色板。 
 

• 如何修改色调。 
 

• 如何修改色彩。 
 

• 如何使用矩形图。 
 

• 如何图层设定。 
 

• 如何改变白平衡。 
 

• 如何储存设定。 
 

• 如何删除储存设定 
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88..11  使使用用修修改改控控制制，，以以手手动动方方式式修修正正图图像像  

修正控制容许利用手动方式更正设定，并在检视窗口中修正图像。在 自定模式 里，可于检视窗口

更改任何控制。 在移动选单上可选取 “Current Unsaved Setting” ；这样便可以利用手动方式

修正图像。  

 

直至你选取其它模式或储存了设定，在综合检视窗口中，现存的设定都会被每个图像所应用。 当

开启多重检视窗口时，调色板的设定会反映在最前的检视窗口上。 

 

开启和关闭修正控制调色板 

开启修正控制，在检视窗口，按上 “Adjustment Control”。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

修正模式p.41 

使用此选项，设定修改模式；在软件里或在 X3F

档案中，可储存和删除指定的 

色调修正p.36 

用作修改曝光、阴影、高光、色域、锐利度和

X3F 补光 (只适用于 X3F 图像)。) 
白平衡 p.40 

用作改变 X3F 档案的白平衡)。 

注意: JPEG 和 TIFF 图像不适用于此项功能。
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色彩修正p.37 

使用此选项将图像色彩中和及修正全部色彩。 

矩形图 (Histogram) p.39 

使用此选项可分析光暗度及确保色调可被组成。 

色彩模式 p.40 

更改色彩模式。 

減少噪訊 p.40 

可以选取有效级别以减少色度及发光性噪讯。 
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最大化、最少化和关闭调色板 

如要在修正控制面版作最大化或最小化 (修正模式、色域修正、白平衡、色彩修正

及矩形图)，请在右边按入最大化(+) / 最小化 (-)按钮  。 

如要关闭修正控制面版，请在左上方按入红色按钮或关

检视窗口。 

 

 

88..22  色色调调修修正正  

利用滑球方式，可控制曝光补偿、光暗度、阴影、高光、锐利度、X3 补光 (只适用于 X3F 档案)和

色彩饱和度。 

 

在自动模式中所有色调修正调整棒，皆由软件自动调控。在 X3 补光里，自动模式只能修正很小部

份；像锐利度，X3 补光数值是依靠图像色彩内容及拍摄者的技术。 

 

如要增加锐利度，或从 X3 补光中增加遮光法和 加光效果，请在选择自动模式后用此作修正。 

 

注意 : JPEG 和 TIFF 图像不适用于 X3F 补光功能。 
 

曝光 

这设定是可以利用 曝光补偿的调较，修改图像的光暗值。在调

整棒面板上，每 1/10 增幅便代表 1/10 光圈值 ( f/stop)。曝

光补偿的滑球面板上是可以相反方向移动的。这情况相对应加或

减光圈值两级。 

对比 

这设定是可以利用对比的调较，修改图像的黑白对比值。当增加

时，白色会较光和黑色僧转黑；如减少时，黑白色都会变较灰。

对比的上下数值是 –2.0 to 2.0。 

阴影 

这设定是可以利用阴影的调较，修改图像的阴影值。当增加数值

时，阴影会转淡；如减少数值时，阴影会转黑。阴影的上下数值

是 –2.0 to 2.0。 

高光 

这设定是可以利用高光的调较，修改图像的高光值。当增加数值时，高光位会转光；如减少数值

时，高光位会转黑。高光的上下数值是 –2.0 to 2.0。 

色彩饱和 

这设定是可以利用色彩饱和的调较，修改图像色彩饱和的值。当增加数值时，色彩会变得丰富；如

减少数值时，色彩会变的得单调。色彩饱和的上下数值是 –2.0 to 2.0。最低的色彩饱和值是 –

2.0；可配合灰阶(黑白)图像。 

銳利度 

这设定是可以利用锐利度的调较，修改图像的锐利度。当数值越大，锐利度越高。锐利度的上下数

值是 –2.0 to 2.0。 

X3 补光 (只适用于 X3F 档案) 

此功能主要是以额外的光能加在阴影区域中，而不会令其变成曝光过度；从而使色泽更光鲜。 X3

补光调整的上下数值是 –2.0 to 2.0。 
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88..33  色色彩彩修修正正  

使用 “色彩修正” 可修改所有图像的色彩。举例说明: 如图像因室内光源变得比较近黄色；当加

入蓝绿色和紫红色时，黄色便会被转化变得较浅色。 

 

你可以手动方式使用 “色彩之轮” ，来修改色彩；请用滑轴来控制不同效果，或 在一个色彩中

和，但 RGB 值并非中和的范围内，收集了样本；便可利用色彩修正点滴器，自动将画面色彩中和。 

 

要检视 “色彩修正轮” ；在画面先开启修正控制调色板，然后放大色彩修正面板。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

使用色彩之轮 

按上和拖曳目标环到颜色圈的任何一处；当你移动到色彩之轮的边缘时，图像的颜色在该范围内会

变得比较鲜艳。 而当离开了颜色圈，目标环亦会消失，而你便可继续寻找所须修改之颜色。 

 

要回复到预设的原始设定，请按入 Reset 按钮。 

 

 

 

 

 

 

 

 

 

 

增加额外的原色 (红、绿或蓝) 

减少补充的色彩 (蓝绿色、紫红色

和黄色) 
 

增加负值的原色 (蓝绿色、紫红色和黄色) 

减少补充的色彩 (红、绿或蓝) 
 

按上 Reset 按钮，便可便可

回复设定到预设状态。 

蓝绿色、紫红色和黄色等色彩值，已被显示在色彩修正过滤单

位 - “CC”  

(color correction filter units) � 即是利用目标环，便

可作色彩修改。 

点滴器按钮 

如要开启或关闭色域修正面

版，请按入主题按钮或 最大

化(+) / 最小化 (-)按钮。 
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使用色彩之轮，以手动方式修改色彩 

如室内灯光令画面变得暗黄；以手动方式便可中和色彩的深浅。在检视窗口中使用放大镜 ，于中

和的灰色范围内，抽出样本。在放大镜上根据 RGB 值，拖曳目标环到色彩之轮上，便可设定 CMY

值来平衡 RGB 值。当色彩样本被中和后，其它图像的色彩亦会保持平衡。 

 

目标环的数值，正代表了色彩之轮上，蓝绿色、紫红色和黄色等纪录单位，皆显示以 色彩修正过

滤单位 “CC” (color correction filter units)。在前页的图表指示着不同颜色 (红、绿、

蓝、蓝绿色、紫红色和黄色) 相互的关系。  

 

如你觉得整幅图像的色彩较浅，但又没有取得色彩的样本时；拖曳目标环到所需颜色之地方便可中

和。举例说明，假如图像显示色彩太红，请将目标环拉到蓝绿色上；即是色彩之轮上，红色的相反

方向。 

 

使用色彩修正点滴器以修改颜色 

在 SIGMA Photo Pro 中，如要于图像里产生灰阶；可使用色彩修正点滴器。在检视窗口上

选取图像所需部份；按入色彩修正点滴器的按钮。滑标便会变为点滴器图示。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

如你想使用不同的

 

如你不喜欢色彩修

用点滴器在基础上

 

將點滴器放置在顏色上並按鈕進入；軟件會評估樣本和作出修正

以令色澤中和。 

參考上述例子，灰色方格的顏色，在藍色方面

比較暗；當使用色彩平衡後，藍色數值由由

206 至 216；同時灰色亦顯現較佳色調。 

 

 

修改後
 
修改前 
户手册  38 

样本，重新将平衡灰色；请按上点滴器按钮，并重复上述步骤。 

正后的结果；请在面板底部按上 Reset  按钮，便会回复到预设设定。你也可使

修改及在色彩之轮上移动目标环，并重新设定修正。 
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88..44  使使用用矩矩形形图图  ((HHiissttooggrraamm))  和和遮遮盖盖提提示示  

阅览 矩形图 (Histogram) 

要观看矩形图，在画面上显示修正控制调色板 及开启矩形图 (Histogram) 面板。 

 

 

 

 

 

 

 

 

 

 

 

矩形图主要显示出图像的光暗分配。有 3 种颜色线来描述红色、绿色和蓝色的光暗度。在检视窗

口 亦会将 RGB 数值显示在右下方上。  

 

阴影数值被显示在面板的左方，中度色泽被放置在中央，而高光数值被安放在面板右方。以上数值

比率的量度单位，会以 0 (最黑阴影) 至 255 (最白高光) 来显示。 

 

在高光提示选择使用、不使用和数值设定 

如要开启和关闭图层提示，请按入在矩形图面板下方的标记匣。当阴影和高光数值跌破特定数值

时；你是可以在之前先设置遮盖提示来提醒自己。 

  

举例说明: 当阴影数值在 8 以下时，你也许会发觉你的打印机或颜色条等不能提供较佳的阴影描

绘；同时如高光数值高于 240 也出现相同情况。根据这数据，当数值超过以上限制，你可以设置曝

光图层提示来提醒自己。要设定限制，在矩形图按上箭头按钮更改设定，直至调整到适当数值为

止。 

 

当你要设定图层的数值；直至图层功

能被重置或消除，在此之前，你可以

手动方式在修正控制调色板上利用滑

球更改设定。这样强的色调修正功能

可协助你优化完成品。 

 

 

按上箭头按钮，可设定

遮盖提示内的阴影和覆

盖数值。 

如要开启和关闭遮盖提

示，请按入标记匣。 

如要开启或关闭矩形图

面版，请按入主题按钮

或 最大化(+) / 最小化 

(-)按钮。 
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88..55  修修改改白白平平衡衡  

在 X3F 档案中更改白平衡 

在图像处理途中，白平衡是可以被修改的。如你想更改指定图

像的光度类别，你可以在适马数码相机上更改光度类别，以符

合不同性质的光源。 

如要修改白平衡，请先在检视窗口内选择图像。接着在检视窗口上的选单，选取 Edit -> White 
Balance 。跟着对话匣便会出现如下: 

 

请使用拉动式选单以选取白平衡设定，可套用在你的图像里。 

日光 (Sunlight) : 当在全日光环境下拍摄相片，请选此模式。 

阴影 (Shade)  : 当在太阳光下的阴影中拍摄相片，请选此模式。 

覆盖 (Overcast) : 当在密云的环境下拍摄相片，请选此模式。 

白光灯 (Incandescent): 当在室内有白光灯的环境下拍摄相片，请选此模式。 

荧光灯 (Fluorescent) : 当在室内有荧光灯的环境下拍摄相片，请选此模式。 

闪光灯 (Flash)  : 当使用适马 EF-500DG 闪光灯拍摄相片，请选此模式。 

自动 ( Auto)   : 相机可自动因应不同环境作出不同白平衡设定。 

黑白 (Monochrome) : 将黑白模式加入白平衡设定*。 

原设定 (Original) : 将白平衡设定还原到拍摄时设定。 

 

白平衡现有的设定会显示在输入的位置上。而在移动选单里可以选择不同的白平衡设定。假如用户

需要进一步有关白平衡设定的数据；请参阅适马数码相机的使用说明书。 

 

当你选取不同的白平衡设定后，X3F 原始图像档案亦会被更新。但是请注意，在主窗口上的预视图

片和在检视窗口上的预视图像是不会显示修改后图像的。 

 

每次你选择了不同的白平衡设定后，新设定便会自动储存在 X3F 档案里。 如要观看修改后的效

果，请等待图像处理完成。 

 

88..66  更更改改色色彩彩模模式式  ((只只适适用用于于  DDPP22  和和  SSDD1155  之之  RRAAWW 数数据据))  

用户可在每次拍摄时, 选取色彩模式, 例如饱和度, 对比度

等。 

 

标准: 标准的色彩模式适合不同情况. 

鲜艳: 调整饱和度和对比度可加强图像色彩更艳丽. 

自然: 和援的饱和度和对比度令图像色彩显得自然. 

肖像: 色彩模式令肤色色调较为轻柔. 最适用于肖像图像                                                       

风景: 此模式将图像中的蓝色和绿色变得更为艳丽.                                                            

还原: 回复原始设定. 

 

注意 : 当以 “单色” 处理图像时，并不会消除其色彩数据。而仍可更改图像的白平衡。 
注意 : 以上的程序并不适用于只读光盘或媒介。 
 

88..77  減減少少色色度度和和發發光光性性的的噪噪訊訊。。((只只適適用用於於使使用用 IISSOO  440000 或或以以上上之之  XX33FF  文文档档。。))  

可以从使用 ISO 400 或以上之图像中减少其色度及发光性噪讯。 

 

发光性噪讯: 可以利用 5 个级别以减低纹状之噪讯。(SC) 

色度噪讯: 可以利用 5级以减低红色或绿色之污点。 
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注意 : 此功能只可以套用在以 ISO 400 或以上所拍摄之 X3F 文档。但不能套用减低噪讯功能于使
用 ISO50、ISO100 及 ISO 200 之图像内。 
注意 : 当开启以 ISO 400 或以上所拍摄之 X3F 文档，此噪讯减低功能将会自动套用。 
 

 

88..88  储储存存和和套套用用自自行行设设定定  

在修正控制调色板套用设定 

如要观看修正模式 (Adjustment Mode)；先在画面显示修正控制调色板，然后开启面板上的  

修正模式 (Adjustment Mode)。 

 

在修正控制调色板上的修正模式设定会显示图像数据，而且和检视窗口上的一样。参阅 章节 

6.5。 

 

 

 

 

 

 

 

在软件内储存设定 

如要在修正控制面版储存现有设定，请在修正模式面版按入储存设定按钮。然后对话匣便会出现。 

 

请在输入栏内键入新设定的名称。要更新现存已储存的设定，请按入你想更新的设定名称。 

 

如设定不能储存，请按入取消按钮并关闭对话匣。 

 

在软件中删除设定 

如要将设定删除，请在修正控制面版下按入删除设定按钮。然后对话匣便会出现。 

 

请按入你想删除的设定名称，然后按上 Delete 按钮。 

 

更换已储存之 X3F 档案设定 

如需要更换原始 X3F 档案的现存设定 (即由适马数码相机所拍摄之档案)，请按入 X3F 按钮。 对

话匣随之出现，并请用户确定是否改变嵌入在 X3F 档案内之设定。 

 

现今用户已经可以因应个人喜好，而更换 X3F 档案内之现存设定；包括自动模式 (Auto Mode) 内

之设定。此功能的好处是令 X3F 档案能更直接、快速及准确地，让用户储存设定更换。假如用户

须回复 X3F 档案的最初设定，请选择自定模式 (Custom Mode) 及从拉下式选单中，选取 “零修

正模式” (Zero Adjust)。当选择了零修正模式 (Zero Adjust) 后，再按入 X3F 按钮，便可返回

原初适马数码相机直接拍摄之 X3F 设定。  

 

如用户要回复 X3F 档案原本之设定，请在移动选单里选取自定模式和选择零修改 ；再次按入 X3F

档案来更换最初从适马数码相机所拍摄的相片。 

 

如用户要处理单一 X3F 档案，请在检视窗口上选择 X3F 模式、修正操控面版或在检视窗口的储存

对话匣中。 

 

如用户要处理一组 X3F 档案，请在主窗口上的的储存对话匣中，选择 X3F 模式。 

按入 X3F 按钮，便可已储存之设定套用在 X3F 档案

中。 

按入”Save Setting” 按钮，便可将实时设定储存

在软件里。按钮可删除软件内已储存设定。 



 

SIGMA Photo Pro 用戶手冊  42 

99   取取得得图图像像数数据据  

在此章节中，你会学到 … 
 

 

• 如何在主窗口和检视视中寻找图像。 
 

• 如何开启在图像数据窗口内的额外数据。  
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99..11  图图像像数数据据  

在主窗口和检视窗口上的图像数据 

当主窗口上的图像被选择时；同时，图像的基本数据也会于预视面板上的数据域内显示。但当你选

择了多重图像时，主窗口上的数据域便会变成空白。 

 

数据包括: 

• 文件名称 

• 图像的日期和时间 

• 光圈和快门速度 

• 感光度(ISO)、对焦距离及解像度 

• 档案大小 (MB) 及 白平衡 -> 像素 

 

在检视窗口也同时显示以上相同的图像数据。 

 

在显现文字数据同时；标记、锁定和转移等状况也会在单一图像的数据域上显示。

假如 TIFF 或 JPEG 等档案是在其它软件上处理的话，只会显示档案类型和锁定状况

等资料。 

 

在预视面板上的图像数据 

被选择图像的数据是显示在主窗口内预视面板的下方的数据域上。此栏会指示被选择图像的数量和

它们档案大小的总和。 

 

在数码相机和计算机面板上的图像数据 

类似的数据会在相机方框和计算机方框中出现。数据会指出有多少个图像

现存在数据夹、硬盘和有多少容量  已经被使用。 

 

 

 

 

 

 

 

 

 

 

 

 

图像数据栏
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99..22  存存取取图图像像数数据据窗窗口口  

图像数据按钮 

在主窗口或检视窗口中，按上图像数据按钮；便可观看个别或群组图像的数据。 

 

图像数据窗口 

“图像数据窗口” 是用作显示图像数据之用。

用户可以从主窗口和检视窗口中，选取所需图

像；然后按入图像数据按钮。 

 

请按入检视窗口内包含的新图像或在主窗口的

新预视图片；便可取得不同图像的数据。当选

择不同图像，图像数据窗口上的数据便会版更

新。 

 

在主窗口和检视窗口关闭前；或注销软件前，

图像数据窗口会仍然开启。 

 

如要关闭图像数据窗口而不影响 SIGMA Photo 

Pro，可按入在左上方的按钮或按入关闭按钮。 

 

在图像数据窗口上显示三个部份，在顶部是图

像档案的基本数据；中间部份是适马数码相机

所拍摄的资料撮要；至于底部是图像处理的数

据，内里列出 X3F 档案的设定。当 X3F 档案被

转为 TIFF 或 JPEG 档案时，用户亦可以从其它图像应用程序中，例如 Adobe Photoshop 等 ，参

考不同图像之基本数据。 

 

 

如用户要复制图像数据窗口上的文字；请按入 Copy to Clipboard 按钮。 

然后在任何文字处理软件里，将文字贴上。你便可以使用它们的打印功

能，将文字打印出来。如你想在 SIGMA Photo Pro 储存图像数据，以方便日后处理的话；十分抱

歉，SIGMA Photo Pro 暂不能使用此功能。但你仍然可以开启文本文件，并在文字处理软件里，将

内容打印出来。 

 



 

S
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在在此此章章节节中中，，你你会会找找到到  …… 
 

 

• 如何打印图像。 
 

• 如何运行幻灯片展示。 
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1100..11  在在主主窗窗口口或或检检视视窗窗口口中中打打印印图图像像  

如要打印图像，请在主窗口和检视窗口按上 Print 按钮或 file -> print。 

 

 

当用户在主窗口中准备打印图像时，接着对话匣出现。打印设定窗口放置在对话匣的左方； 

而打印预视窗口则放置于右方。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

打印设定窗口 

 

口 

打印尺寸 

打印预视窗口 
来源 : 

用户可以从图像群里选取所需图像，标

记图像或选取图像。) 
 

 打印设定窗
修改模式 : 

当用户想打印，便可在修改模式选择 X3F、

Auto 或自定(只有 X3F 适用)。) 
打印设定 : 

用户可在此设定打印规划、图像复印数目

等。
46 

打印尺寸 : 

用户可决定在同一张纸上的打印图像数

量。 

打印机设定 : 

如用户想更改打印机设定，请按入打印设

定按钮。而用户可在个别打印机的设定

中，自行更改打印尺寸或质素等。) 
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打印尺寸 

用户可选取图像的编号以打印在纸上。打印状态会显示在右方。 

 

例如: 以 A3 型式打印 

203.2×254mm (2)-A3 (297×420mm) 

127×177.8mm (4)-A3 (297×420mm) 

101.6×152.4mm (4)-A3 (297×420mm) 

76.2×127mm (10)-A3 (297×420mm) 

50.8×76.2mm (25)-A3 (297×420mm) 

38.1×38.1mm (70)-A3 (297×420mm) 

Fit to printable area (符合列打印范围) 

 

 

 

注意: 适合的打印尺寸为 8x10, 5x7, 4x6, 3x
如图像尺寸大于预设纸张尺寸，打印选单便不会
 

如用户的打印图像大于 8x10 (寸)，请选择打印

 

自動旋轉 

按上 “自动旋转” 可将图像自动转动至符合纸

 

自動整理 

当选取自动整理，图像会以打印尺寸自动整理；

移动中改变版面。 

 

圖像副本 

用户可在此设定打印副本数目。 

 

资料打印 

打印时可在页尾加入基本数据，如文件名称和快
 

页首 / 页尾打印 

打印时可在页首或页尾加上文字。 
 

 

当完成以上设定，请按入打印按钮。如用户不打

 

 

注意 : 当用户在检视窗口中进行打印时，只能
选取图像。 
 

纸张尺寸

数
打印在同一张纸上的图像
打印尺寸
 47 

5, 2x3 and 1.5x1.5 (寸) 
显示其尺寸数据。 

范围。 

张大小。 

如将鼠标浮标放置在预视图像上，用户亦可从图像

门速度。 

印，请按入取消按钮。 

打印指定图像；因此用户此时不能使用修正模式及

符合所选之纸张尺寸 
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1100..22  在在主主窗窗口口展展示示幻幻灯灯片片  

 

 

1. 将鼠标浮标放在预视方框内的任何图像，并在选单中选取 “幻灯片”)  

 

2.在上方按入幻灯片按钮->幻灯片展示对话匣便会出现。对话匣内容如下。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

开始展示幻灯片，请按入 Play 按钮；如不观看幻灯片，请按

键盘上按间隔键。当幻灯片正在运作，在键盘上按入 Esc 键，

 

幻灯片展示的显示格式 

 

挥动 

此幻灯片播放令图像从左方

 

 

 

 

 

 

涟漪 

幻灯片播放像涟漪般，从屏

 

 

 

 

 

 

页面翻动 

圖像會像翻頁般從左角翻下

 

 

 

 

 

渐变 

可从选单中选取不同的播放形态。亦可

从选单中选择变焦、渐褪、转动、页面

翻动、闪电、溶解、分裂、复印。 

Duration.,(持续) 

可从选单中选择显示时间(秒)，每幅可出

由 1 至 10 秒。 
循环 

请按入循环，便会重复幻灯片展示。
48 

入 Cancel 按钮。如要标记图像，在

幻灯片展示便会完毕。 

挥动过来。 

幕中央扩散。 

。 

现
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球状  

不规则的圆形会以顺时针方向转动。 

 

 

 

 

 

 

闪光 

闪光从屏幕中央出现并带出下一幅图像。 

 

 

 

 

 

 

溶解 

图像会像溶解般褪去而下一幅图像接上。 

 

 

 

 

 

 

分裂 

下一幅图像会像斑点般分裂地出现。 

 

 

 

 

 

 

复印机 

显示中之图像会像在复印后消失；而下一幅图像便会在光柱中

出现。 
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